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You will learn: 

• About SolidMill Traditional machining technology and 

machining cycles 

• How to create a milling tool 

• How to create features for milling operations 

• How to create a stock model 

• Techniques to quickly remove stock material 

• Drilling techniques for hole patterns and a milled hole 

• Simulation of machining process 
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1. The ESPRIT Graphical User Interface (GUI) 
 
Let’s start by taking a look at the ESPRIT screen. This window is displayed when you create a new 
file or open an existing one. 
 
The ESPRIT window contains: 
 
1. Menus and default toolbars along the top of the screen. You can select commands from the 

menus or from toolbars.  
2. A graphic work area where you can view your work. This is the largest area of the screen.  
3. The Prompt area, at the bottom left of the screen, displays prompts that tell you what to do 

next. Always pay attention to what the prompt is telling you.  
4. The Status area, at the bottom of the ESPRIT screen, provides dynamic information about the 

current work environment. As you select commands or move the cursor, the information is 
constantly updated.  
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ESPRIT also provides two specialized windows that provide additional information about the parts 

you are working on and provide an excellent way to manage your work. 
 
5. The Project Manager consists of a tabbed set of windows that list every feature, every cutting 

tool, and every operation in the current session. The Project Manager lets you manage, sort, 
and reorder these items. To view the Project Manager, press the F2 key or click Project 
Manager on the View menu. 
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6. The Property Browser displays the specific properties of any item selected in the graphic 
work area or the Project Manager. The types of properties displayed depend on the type of 
item selected. You can view and change individual properties for the selected item. To view 
the Property Browser, click Properties on the View menu or hold down the Alt key as you 
press Enter.  
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Default Toolbars 
 
The default toolbars are located near the top of the ESPRIT screen. 
 
1. The Standard toolbar has file management commands that let you create, open, save, and 

print files. This is also where you can find the Copy command when you want to copy elements 
in the work area.  

2. The View toolbar has several commands that let you control the display in the work area, such 
as zooming and rotating the view plus commands that let you choose whether to display parts 
in shaded or wire frame modes.  

3. The Edit toolbar gives you selection tools that let you filter the types of elements that can 
be selected or automatically select (group) multiple elements from the selection of a single 
element.  

4. The Layers and Planes toolbar has commands for creating and selecting work planes, layers, 

and view planes.  
 

1 2 3 4 
 
 
 

 



4 

 

 
 
The Smart Toolbar 
 
Use the Smart toolbar to quickly display and hide ESPRIT toolbars based on the type of work you 

want to do. 
 
The first three icons on the toolbar relate to the machining modes in ESPRIT: milling, turning, and 

wire EDM.  
 
 
 

 

If you click “Switch to SolidMill”, the toolbar is updated to display commands that let you create 
milling tools and operations. If you click “Switch to SolidTurn”, the milling commands are hidden 
and new commands display that let you create turning and mill/turn operations and tools.  
 
 
 
 

Displaying the XYZ Axis and the UVW Axis 
 
You can display two types of axes in the work area: 
 
XYZ Axis: The global axis positioned at the global origin point 
 
UVW Axis: The local axis of the current work plane 
 
The display of the two axes is controlled on the View menu. 
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Shaded and Wireframe Displays 
 
For solids and surfaces, you can set the display to shaded or wireframe mode.  
 
 
 

 

Shaded Wire: Creates a shaded image with wireframe.   
 

Shaded: Creates a shaded image.  
 

Hidden Wireframe. 
Wireframe.  
 
 
Views 
 
ESPRIT provides several standard view orientations.  
 
 
 
 
 
 
 
 

 

When you change from one view plane to another, the display in the work area rotates to the 
new view orientation and the display automatically zooms to fit all elements within the screen.  
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2. SolidMill Traditional Machining Cycles 
 
All SolidMill Traditional machining cycles are displayed on the SolidMill Traditional toolbar and on 
the Machining menu under SolidMill Traditional. To display the SolidMill Traditional toolbar, click 
‘Switch to SolidMill’ on the Smart toolbar and then click SolidMill Traditional.  
 
 

 

 Facing - Removes a flat portion of stock material based on a feature that matches the stock 
perimeter. SolidMill Facing quickly removes material at the depth (or depths) you specify with 
simple linear passes followed by a final contouring pass around any islands to provide a uniform 
amount of stock on wall areas. The linear and contouring passes are combined into a single 
operation to save you time and to guarantee a consistent amount of stock on floors and walls.   

 Pocketing - Removes material inside a closed boundary. Within a single pocketing operation, you 
have the option to create separately definable phases for roughing, wall finishing, and floor finishing 
passes that each let you use a different tool. When a pocket or face profile feature is chosen, the 
operation automatically finds any subordinate islands within the feature boundary.   

 Trochoidal Pocketing - Removes material inside a closed boundary using the fastest possible 
feed rates. Trochoidal Pocketing quickly roughs parts at a constant material removal rate and 
provides multiple levels of control over tool motion pattern, feed rates, and cutter load. Although 
developed for high-speed machining, Trochoidal Pocketing brings benefits to any type of machine 
by providing a more constant tool load and a better surface finish.   

 Contouring - Creates vertical or tapered cuts along the contour of a selected profile. Within a 
single contouring operation, you have the option to create separately definable phases for roughing 
and finishing. The same tool is used for both roughing and finishing, although you can define 
different incremental depths for finishing passes as well as different speeds and feeds.   

 Rest Machining - Creates an operation to remove material remaining from previous operations. A 
rest machining operation can be applied to any existing SolidMill Traditional operation. The previous 
operation becomes the “parent” operation and the rest machining operation applied to it becomes the 
“child” operation. The child operation inherits many of the settings from the parent operation. The 
parent operation is used as the basis for calculating the areas to machine.   

 Drilling - Creates a drilling operation. Several types of drilling cycles are supported, including 

canned cycles.   
 Spiraling - Creates either spiral or helical cutting passes based on the selection of a feature with 

a circular shape or a PTOP feature.   
 Threading - Creates a standard threading or single-point threading operation using basic milling 

technology.   
 Manual Milling - Creates rapid or feed moves based on manually selected elements or 

coordinate locations. Manual Milling creates a tool path on the centerline of the tool without 
compensation.   

 Wire Frame Milling - Creates a milling operation based on wire frame geometry. This command lets 

you create a simple freeform milling operation from planar geometry. Two separate profiles are used. 

One profile is swept along the other to create a 3-dimensional shape for the toolpath.  
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3. Open the part file 
 
On the Standard toolbar, click Open.  
 
 
 

Browse and select the following file: milled_part.esp. 
 
Set the view to ‘Isometric’.  
 
 
 

If the Project Manager is not displayed, press F2.  
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4. Create a milling tool 
 
This file already contains several types of tools, such as end mills, drills, and even a custom mill for 

cutting the milled hole. 
 
You will learn how to create a face mill that will be used to remove the stock at the top of the part. 
 
Milling tools can be created from the Tool Manager or from commands on the Milling Tools 

toolbar.  
 
 

 

ESPRIT provides an extensive list of pre-defined milling tools. If you use a very specific type of tool 
that is not on the list, you can create a Custom Mill from geometry you define. 
 
Instructions on how to create a custom mill are provided in ESPRIT Help. 
 
The Tool Manager 
 
All cutting tools are managed on the Tools tab of the Project Manager. The Tool Manager lets you 
create, edit, copy, rename, and delete tools. You can also transfer tools between the Tool 
Manager and the KnowledgeBase. 
 
The Tool Manager displays all the available tools in the current document. Tools are grouped 
by where they are mounted on the machine: on a milling head or a lathe turret (for a mill-turn 
machine).  
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Create a face mill tool 
 
You will create a new face mill tool with a diameter of 60 mm. This face mill has 6 cutting inserts 

that have a rectangular shape. 
 
On the Smart toolbar, click Milling Tools.  
 

 

Click Face Mill.  
 

 

On the General tab: 
 
• Set ‘Tool ID’ to ‘FM 60’  
• Set ‘Tool Number’ to 1  
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On the Machine tab: 
 

• Set ‘Movement X, Y, Z’ to ‘Home’ for all 
three positions  

• Set ‘Turret Name’ to ‘Head’  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

On the Holder tab: 
 

• Set ‘Holder Diameter’ to 60  
• Set ‘Overall Length’ to 100  
• Set ‘Tool Length’ to 80  

 
 
 
 
 
 
 
 

 

On the Shank tab: 
 

• Set ‘Type’ to ‘Cylindrical’  
• Set ‘Shank Diameter’ to 30  
• Set ‘Cutting Length’ to 1.5 
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On the Cutter tab: 
 
• Set ‘Tool Diameter’ to 60  
• Set ‘Bottom Clearance’ to 10  
• Set ‘Number of Inserts’ to 6  
• Set ‘Insert Type’ to ‘Rectangular’  
• Set ‘Corner Radius’ to 1  
• Set ‘Insert Width’ to 30  
• Set ‘Insert Height’ to 10. 
 
Click OK to add the new tool to the Tool Manager.  
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5. Create milling features 
 
Milling features have machining properties that help to automate milling operations. These 
properties include depth, draft, cutting side, and whether material is removed on the inside or 
outside of the feature. These properties assist the user because SolidMill technology is designed to 
use these properties each time a milling operation is created. If the feature is modified to change 
any of the machining properties, such as a change in the depth property, any milling technology 
that is applied to that feature can be updated quickly by simply rebuilding the operation. 
 
When features are created on a solid model, ESPRIT uses automatic feature recognition to analyze 
the part geometry and automatically create the appropriate features for milling operations. The 
user is not limited to selecting only the solid model. The user can also select sub-elements of  
a solid model, such as faces and face loops, to create features on a specific portion of the solid 

model.  
 

 

Set the work plane 
 
When automatic feature recognition is used, the direction of the W axis of the active work plane 
controls the direction of feature recognition. This allows you to create features automatically on 
different sides of a part. 

 
Make sure the work plane is set to ‘XYZ’.  

 
 
 
 

Recognize the pockets 
 

In the status area, make sure HI mode and SUB-ELEMENTS mode are active.  
 
 

 

On the Smart toolbar, click Create Features.  
 

 

Pocket Feature Recognition uses the ‘Maximum Diameter’ parameter located in the Feature 
Parameters dialog to recognize cylindrical pockets. Any cylinder with a diameter greater than the 
‘Maximum Diameter’ will be recognized as a pocket. 
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Click Feature Parameters.  
 

 

• Click the arrow button next to ‘Max Diameter’ and use HI mode to select the edge of a hole on 

the corner of the part  
• Click OK  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Select the solid model  
• Click Pocket   
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Rename the pocket features 
 
Features for the pockets and island were created automatically and placed in a folder in the 
Feature Manager. 

 
It is helpful to give descriptive names to features. This makes it easier to select the correct 
feature when you want to apply a machining operation and it is extremely helpful to other users 
if they need to modify operations at a later time. 

 
• Click the Features tab in the Project Manager  
• Expand the folder for the pocket  
• Right-click on the feature for the pocket in the middle of the part  
• Select ‘Rename’  
• Rename the feature to ‘Medium Pocket’ and press Enter  
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• In the same way, select the feature for the slot and rename it ‘Slot’  
• Rename the small pocket ‘Small Pocket’  
• Rename the cylindrical pocket ‘Milled Hole - Upper’  
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Recognize the boundary   

• Click Face Profiles   
• Use HI mode to select the face loop around the top of the part  
• Click OK  
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Recognize the drilled holes   

• Click Holes   
• The value for ‘Max Diameter’ is already set to the diameter of the hole you selected for the 

pocket features  
• Click OK  
• Rename the group of large holes ‘Counterbore’  
• Rename the group of small holes ‘Countersink’  
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Create a hole feature for the milled hole 
 

It is more efficient to pre -drill the milled hole before applying a milling operation. To do this, 
you can create a simple Hole feature that matches the size of your largest drill.  

• Click Holes   
• Set ‘Max Diameter’ and ‘Min Diameter’ to 42  
• Click OK  
• Press Alt+Enter to display the Property Browser  
• In the Feature Manager, select the new hole feature  
• In the Property Browser, change the value for the Depth 

property to 38.1  
• Change the value for the Diameter property to 30 and 

press Enter  
• Close the Property Browser  
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6. Create a stock model 
 
Stock models for milling operations are created in Simulation Parameters on the Simulation 

toolbar. 
 
Stock models are created as solid models that aid in the visualization of material removal during 
the simulation process. Stock models can be defined in a variety of ways: from an existing solid 
model, from a feature, from an external file, and from points that define a block. 
 
In this lesson, you will create the stock model from a chain feature that defines the shape of the 

boundary.  
 

On the Smart toolbar, click Simulation.  
 

 

Click Simulation Parameters.  
 

 

• Click the Solids tab  
• Set ‘Type’ to ‘Stock’ and set ‘Create From’ to ‘Extrusion’  

 
 
 
 
 
 
 
 
 
 
 
 
 

 

• Click the arrow button and select the feature ‘Stock Profile’ in the work area  
• Set ‘Z+’ to 1  
• Set ‘Z-’ to 53.1  
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• Set ‘Indexing’ to ‘None’  
• Click Add  
• Click OK  
• To view the new stock model, click Single Step   
• Click Stop to exit simulation mode   
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7. Remove excess material 
 
In this project, the part is cut from standard rectangular stock. The first thing you need to do is 

remove the excess material from the top and around the sides of the part. 
 
To do this, you will first create a facing operation to quickly remove as much stock as possible from 
the top of the part. Then you will create a 3D contour around the island on the top face. You will 
finish by roughing and finishing the outer profile of the part.  
 

 

Face the top of the part 
 

For this facing operation, there is an island on the face that must be avoided. The Facing 

command lets you select and avoid islands and pocketed areas. 
 

This operation will start slightly below the selected feature and cut at incremental depths of 
8mm in a simple back and forth tool motion. A stock allowance of 0.5 mm will remain on the 
walls of the island after the operation is complete. No stock allowance will remain on the floors. 

 
XAs you enter values on the technology page you can use the Tab key to move from 

oneparameter to the next. Be careful not to press the Enter key. Pressing the Enter key 
will apply the current settings to the selected feature. 

 
In the Feature Manager, select the feature ‘Stock Profile’. 

 
On the Smart toolbar, click SolidMill Traditional.  

 

 

Click Facing.  
 

 

• On the dropdown menu, click ‘System Default All’ to reset all the technology parameters to 

the system default settings  
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• Under ‘Operation 

Name’, type Facing  
• Select the tool ‘FM 60’ 

for ‘Tool ID’  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

• Click the Strategy tab  
• Set ‘Overhang Direction’ 

to ‘One Way’  
• For detailed information 

about this setting, click  
Help.  

• Set ‘Include Islands’ to 

‘Yes’  
• Set ‘Stock Allowance 

Walls’ to 0.5  
• Set ‘Total Depth’ to 15  
• Set ‘Incremental Depth’ 

to 8  
• Set ‘Starting Depth’ to -1 
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• Click the Islands tab  
• Click inside ‘Island Features’ and then select the island feature in the work area  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

• Click the Links tab  
• Set ‘Entry Mode’ to 

‘Rapid Down, Feed Over’  
• Set ‘Exit Mode’ to ‘Feed 

Over, Rapid Up’  
• Click OK 
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Create a simple 3D milling operation 
 
For this operation, you will use two existing features. The ‘Wireframe Drive Curve’ defines the 
curved profile for the walls around the island on the face. The ‘Wireframe Basic Curve’ feature is 
located on the top face of the island and defines the path the profile will follow.  
• Select the feature ‘Wireframe Basic Curve’  
• Click Wire Frame Milling   
• On the drop-down menu, click Open  
• Open the following technology file: Processes\M1-Wire_Frame_Milling.prc  
• Click the Wire Frame tab  
• Click the arrow button next to ‘Drive Curve’ and select the drive curve feature in the work area  
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• Notice that ‘Machine Along’ is set to ‘Basic’ so that the flow lines of the tool path will follow 
the shape of the basic curve  

• Click OK  
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Rough and finish the outer profile 
 
To cut the external profile of the part, you will first rough the profile with a 30mm end mill that 
will leave 0.5 mm stock on the walls and then finish with a 20mm end mill. Because the roughing 
and finishing operations use very different settings, you will create two separate Contouring 
operations.  
• Select the profile feature on the boundary of the part  
• Click Contouring   
• Open the file: M2-Contour_Rough.prc  
• Click the Strategy tab  
• Notice that there will be 1 rough pass and no finish pass. ‘Stock Allowance Walls’ is set to 0.5 

and ‘Incremental Depth’ is set the same as the diameter of the tool.  
• Click OK  
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• With the same feature selected, click Contouring   
• Open the file: M3-Contour_Finish.prc  
• On the Strategy tab, 1 rough pass is generated with no stock allowance  
• Click OK  
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8. Cut the pockets and slot 
 
The part in this project contains two pockets and a slot. ESPRIT offers two types of pocketing 

operations that you will use to cut each pocket: Trochoidal and Traditional.  
 

 

Rough the medium pocket 
 
To mill the medium pocket, you will first remove as much material as possible as quickly as 
possible with a Trochoidal Pocketing operation. A stock allowance of 0.5mm will remain on the 
walls and floors of the pocket.  
• Inside the ‘Pocket’ feature group, select the feature ‘Medium Pocket’  
• Click Trochoidal Pocketing   
• Open the file: M4-Rough_Pocket.prc  
• On the Strategy tab, notice that ‘Trochoid’ tool motion is used and that the trochoid step over 

is set to 25% of the tool diameter when ESPRIT detects that the tool is fully engaged in the 
material.  

• For details on trochoidal tool motion, click the Help button  
• Click OK  
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Notice that the tool path starts in the largest area of the pocket and spirals outward until it 
reaches an obstacle. Then the tool path changes to adjustable curves that adapt to the shape of 
the pocket.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Finish the medium pocket 
 
You will use a traditional Pocketing operation to first finish the walls and then the floors of the 
pocket.  
• Select the feature ‘Medium Pocket’  
• Click Pocketing   
• Open the file: M5-Finish_Pocket.prc  
• On the Strategy tab, notice that ‘Rough Pass’ is set to ‘No’ and both ‘Wall Finish Pass’ and 

‘Floor Finish Pass’ are set to ‘Yes’  
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• Click the Wall Finish tab  
• A single contouring pass will be applied to the walls with a stock allowance of 0.2 mm  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

• Click the Floor Finish tab  
• The floor of the pocket will be finished with a constant step over of 2.5 mm and no stock 

allowance  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



31 

 

• Click the Links tab  
• ‘Passes Order’ is set to ‘R | AW | AF’. This means that any roughing passes will be applied first. 

‘AW’ means that All Walls will be cut next. ‘AF’ means that All Floors will be cut last.  
• Click OK  
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Remove material in the corners 
 
To remove any material remaining in the corners, you will apply a Rest Machining operation. 

 
• Select the feature ‘Medium Pocket’  
• Click Rest Machining   
• Open the file: M6-Corner_Finish.prc  
• On the Strategy tab, notice that the tool motion for area clearing is set to ‘Concentric In’. Area 

clearing is applied when an area has more than one exposed edge of material (for example, 
between a wall and an island). Corner clearing is applied when there is only one exposed edge 
(corners).  

• Click OK  
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Rough and finish the small pocket 
 
You will use a single pocketing operation to rough the pocket and then finish the walls using a 
different tool. 
 
• Select the feature ‘Small Pocket’  
• Click Pocketing   
• Open the file: M7-Small_Pocket.prc  
• Click OK  
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Cut the slot 
 
To cut the slot, you will use a traditional Pocketing operation using a tool with a diameter the 
same width as the slot. The tool will enter the material using a ramping move and then cut the 
slot with a single pass.  
• Select the feature ‘Slot’  
• Click Pocketing   
• Open the file: M8-Slot.prc  
• Click the Rough tab and notice that ‘Entry Mode’ is set to ‘Ramp Along Pass’. The tool will 

enter the slot with a long ramping pass at a 10 degree angle.  
• Click OK  
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9. Mill and drill the holes 
 
This part has different types of holes, including a milled hole. For this project, you will create 

drilling and spiraling operations depending on the type and size of the hole.  

 

Pre-drill and mill the large hole 
 
The milled hole has a diameter of 42 mm. You will cut this hole in two steps. First, you will drill 
the hole with a 30mm drill. Then, you will create a Spiraling operation to mill the upper diameter 
to a depth of 30mm.  
• Select the Hole feature for the milled hole  
• Click Drilling   
• Open the file: M9-Drill_Milled_Hole.prc  
• Click OK  
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• In the ‘Pocket’ feature group, select the feature ‘Milled Hole - Upper’  
• Click Spiraling   
• Open the file: M10-Spiral.prc  
• On the Strategy tab, notice that ‘Strategy’ is set to ‘Tangent Arcs’. The tool path will be created 

as arcs that are tangent to one another.  
• Click OK  
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Drill the holes 
 
• In the Feature Manager, right-click on the feature ‘Counterbore’ and select File > Open Process  
• Open the file: M11-Counterbore.prc  
• Again, right-click on the feature ‘Counterbore’ and open the file: M12-Drill_Counterbore.prc  
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• Right-click on the feature ‘Countersink’  
• Open the file: M13-Countersink.prc  
• Again, right-click on the feature ‘Countersink’ and open the file: M14-Drill_Countersink.prc  
• To view the settings for any of these operations, double-click on an operation to open the 

technology page  
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10.     Simulate milling operations 
 
Operations are simulated in the same order as they are listed in the Operation Manager. 
 
On the Smart toolbar, click Simulation.  
 

 

• Click ‘Run’ to start the simulation . 

• Click ‘Pause’ to temporarily stop the simulation . 

• Click ‘Run’ again to restart the simulation . 

• When the simulation is finished, click ‘Stop’ .  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


